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Course Agenda – day 1

Introduction - General Simulation Concepts

The User Interface - Graphical Flowsheet Definition

Basic Input - Getting Around the Graphical User Interface

Unit Operation Models - Overview of Available Unit 
Operations

Separator – Two-phase & Three-phase Flash Calculation

DSTWU – Determination of Nmin and Rmin

DISTIL – Preliminary Separation Approximation

RadFrac - Multistage Separation Model



Course Agenda – day 1

Heat Exchangers - Heaters and Heat Exchangers

Pressure Changers - Pumps, Compressors, Pipes and 
Valves

Reactor Models - Overview of Available Reactor Types

Full-Scale Plant Modeling Workshop : Additional

Simulate a Methanol Plant

Simulate a PX Plant

Simulate a CDU



Introduction

Objective:

Introduce general flowsheet simulation concepts and 

Aspen Plus features



Introduction
•What is flowsheet simulation?

- Use of a computer program to quantitatively model the 
characteristic equations of a chemical process

•Uses underlying physical relationships
- Mass balance
- Equilibrium relationships
- Summation of Compositions
- Enthalpy Balance
- Rate correlations (reaction and mass/heat transfer)

•Predicts
- Stream flowrates, compositions and physical properties
- Operating conditions
- Equipment sizing



화학공정 모사기란 무엇인가?

• 화학공정모사기(Chemical Process Simulator)는
화학공정을열역학을이용하여 수학적으로
모델화하여서 이를 Computer Hardware를
이용하여실제공장에서 일어나는상황을
묘사하는 Software이다. - 1988

Henry Jo



Process Simulation

Reality
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공정모사의 목적
(Purposes for Simulation?)

• 새로운 공장의 설계

New Plant Design

• 기존 공장의 개조 (증설)
Existing Plant Revamp (Expansion)

• 기존 공장의 운전조건 진단

Existing Plant Operations 

• 교육 훈련

Engineer Training



Advantages of Simulation

• Reduces plant design time
– Allows designer to quickly test various plant 

configurations

• Helps improve current process
– Answers “what if” questions

– Determines optimal process conditions within given 
constraints

– Assists in locating the constraining parts of a process 
(debottlenecking)



공정 모사의 장점
Advantages of Simulation

• Faster Calculations - More solutions

• Accurate Results

• Standardization

Pure Components : 1,550개

Binary Database : 10,000 VLE & 3,000 LLE

Thermodynamic Methods over 60 Models

• Solution of Recycle Processes

• Less Costly than Pilot Plant Tests !!



공정 모사의 장점 (I)
Faster Calculations

• The equilibrium flash separator is the simplest 
equilibrium-stage process with which the designer 
must deal. Despite the fact that only one stage is 
involved, the calculation of the compositions and the 
relative amount of the vapor and liquid phases at any 
given pressure and temperature usually involves a 
tedious trial-and-error solution.

Buford D. Smith, 1963



공정 모사의 장점 (II)
Standardization

• Pure Component Database

1,550개가량의순수성분데이터베이스

(Commonly Used Components > 100)

• Binary Database

10,000여쌍의이성분계에대한매개변수내장

(100)x(100-1)/2 = 4950 BIP’s

• Thermodynamic Option
60여개의열역학모델식내장

EOS Model, LACT Model, Special Package !



공정 모사의 장점 (III)
Solution of Recycle Process

• Sequential-Modular Approach
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What is the composition of stream PRODUCT?

• To solve this problem, we need:
– Material balances

– Energy balances

REACTOR

FEED

RECYCLE

REAC-OUT

COOL

COOL-OUT SEP

PRODUCT

General Simulation Problem



Approaches to Flowsheet Simulation
• Sequential Modular

– Aspen Plus is a sequential modular simulation 
program.

– Each unit operation block is solved in a certain 
sequence.

• Equation Oriented
– Aspen Custom Modeler (formerly SPEEDUP) is an 

equation oriented simulation program.
– All equations are solved simultaneously.

• Combination
– Aspen Dynamics (formerly DynaPLUS) uses the 

Aspen Plus sequential modular approach to initialize 
the steady state simulation and the Aspen Custom 
Modeler (formerly SPEEDUP) equation oriented 
approach to solve the dynamic simulation.



Aspen Plus Basics

• The best way to learn Aspen Plus concepts is by 
using Aspen Plus. This session leads you 
through an example Aspen Plus simulation to 
explain how to open a file, enter data, run a 
simulation and examine results.

• It will allow one and half hour for this session. 



The User Interface

Objective:

Become comfortable and familiar with the Aspen Plus 
graphical user interface

Aspen Plus References:

•User Guide, Chapter 1, The User Interface
•User Guide, Chapter 2, Creating a Simulation Model
•User Guide, Chapter 4, Defining the Flowsheet



Help Button

Next button

Menu bar

Flowsheet
Work space

Scroll bars

Select Mode
button

Model Library

Prompt area

Status indicator



Opening a File

You can open a file for an Aspen Plus simulation by 
either:

• Double-clicking the file from Windows Explorer
• Selecting the open command from the File menu in 

Aspen Plus

In this session, you will use the open command on the 
File menu.
- To display the File menu, click File on the menu bar.



Aspen Plus displays the File menu:



• From the File menu, select Open. 

The Open dialog box appears. Your default working directory is 
displayed in the Look In box. You can navigate to the folder 
containing a file by using the Look In box or the Look In Favorite 
button,    .

• Click the Look in Favorite button.



Aspen Plus modeling Procedures
1. Define the process flowsheet modeled and the purpose of the model.

(Setup Specifications Global) (Title Card in PRO/II)

2. Select the units of measurement for input data and output.

3. Specify what chemical components will be present in the streams of the

flowsheet.

(Components Specifications Global) (Component Data in PRO/II)

4. Specify the methods and models to be used for calculating physical

properties.

(Property Specifications Global) (Thermodynamic Data in PRO/II)

5. Define the feed streams to the process.

(Stream Specifications Global) (Stream Data in PRO/II)

6. Convert the process flowsheet into unit operating blocks and choose an

appropriate model for each block.

(Block Specifications Global) (Unit Operations Data in PRO/II)

7. Specify the performance of each unit operating block to represent the design 
and operating conditions of the process.

(Design Specifications Global) (Specifications in PRO/II)



The minimum required inputs (in addition to the 
graphical flowsheet) to run a simulation are:

­Setup Title

­Components Component Data

­Properties Thermodynamic Data

­Streams Stream Data

­Blocks Unit Operations Data

Basic Input



Using the Mouse

• Left button click - Select object/field

• Right button click - Bring up menu for 
selected object/field,  
or inlet/outlet

• Double left click - Open Data Browser object 
sheet 

Reference:  Aspen Plus User Guide, Chapter 1, The User Interface



Ex 1 : Two-phase Flash

•An equimolar stream of n-pentane and n-hexane, at 130oF and 
73.5 psia, is fed a flash vessel, where it is flashed to 13.23 psia with
vapor liquid products in equilibrium at 120oF. 

•Use ideal Raoult’s law for the simulation of this system.

T = 120oF
P = 13.23psia

73.5 psiaPress.

130 oFTemp.

50 mole %NC6

50 mole %NC5

Feed 
Characterization

V, y = ?

L, x = ?
Q

Ki for each components

When finished, save in backup
format (Run-ID.BKP).
Filename: FLASH.BKP



Start with the General with English Units 
Template



Choose the appropriate icons for the block

• To place a block on the flowsheet:

1. Click on a model category tab in the Model Library.

2. Select a unit operation model. Click the drop-down arrow 
to select an icon for the model.

3. Click on the model and drag it to the flowsheet where 
you want to place the block, then release the mouse 
button.



Choose the appropriate icons for the block

• To place a stream on the flowsheet:

1. Click on the stream icon in the Model Library.

2. If you want to select a different stream type (Material, 
Heat or Work), click the down arrow next to the icon and 
choose a different type. 

3. Click a highlighted port to make the connection. 

4. Repeat step 3 to connect the other end of the stream.

5. To place one end of the stream as either a process
flowsheet or product, click a blank part of the Process 
Flowsheet window.

6. Click the right mouse button on stop creating streams.



Graphic Flowsheet operations

• To display an input for a Block or a Stream in the Data 
Browser:
1. Double click the left mouse on the object of interest.

• To rename, Delete, Change the icon, provide input or view 
results for a block or stream:

1. Select object (Block or Stream) by clicking on it with the left mouse

button.

2. Click the right mouse while the pointer is over the selected object icon

to bring up the menu for that object. 

3. Choose appropriate menu item.



Automatic Naming of Streams and Blocks

• Stream and block names can be automatically assigned by 
Aspen Plus or entered by the user when the object is 
created.

• Stream and block names can be displayed or hidden.

• To modify the naming options:

- Select Options from the Tools menu.

- Click the flowsheet tab.

- Check or uncheck the naming options desired.



Setup

Most of the commonly used Setup information is entered on 
the Setup Specifications Global sheet:

• Flowsheet title to be used on reports

• Run type 

• Input and output units

• Valid phases (e.g. vapor-liquid or vapor-liquid-liquid)

• Ambient pressure

Stream report options are located on the Setup Report 
Options Stream sheet.



Step 1 : general process information (Setup Specifications)



Step 1 : general process information (Setup Specifications) continued



Status Indicators

 
Symbol 

 
Status 

 
 

 
Input for the form is incomplete 

 
 

 
Input for the form is complete 

 
 

 
No input for the form has been entered. It is optional. 

 
 

 
Results for the form exist. 

 
 

 
Results for the form exist, but there were calculation 
errors. 

 
 

 
Results for the form exist, but there were calculation 
warnings. 

 
 

 
Results for the form exist, but input has changed since 
the results were generated. 

 



Run Type 

Flowsheet Standard Aspen Plus flowsheet run including sensitivity studies and optimization.  

Flowsheet runs can contain property estimation, assay data analysis, and/or property analysis 
calculations. 

Assay Data 
Analysis 

A standalone Assay Data Analysis and pseudocomponent generation run 

Use Assay Data Analysis to analyze assay data when you do not want to perform a flowsheet 
simulation in the same run. 

Data 
Regression 

A standalone Data Regression run 

Use Data Regression to fit physical property model parameters required by ASPEN PLUS to 
measured pure component, VLE, LLE, and other mixture data. Data Regression can contain 
property estimation and property analysis calculations. ASPEN PLUS cannot perform data 
regression in a Flowsheet run. 

PROPERTIES 
PLUS 

PROPERTIES PLUS setup run 

Use PROPERTIES PLUS to prepare a property package for use with Aspen Custom Modeler 
(formerly SPEEDUP) or Aspen Pinch (formerly ADVENT), with third-party commercial 
engineering programs, or with your company's in-house programs. You must be licensed to use 
PROPERTIES PLUS. 

Property 
Analysis 

A standalone Property Analysis run 

Use Property Analysis to generate property tables, PT-envelopes, residue curve maps, and other 
property reports when you do not want to perform a flowsheet simulation in the same run. 
Property Analysis can contain property estimation and assay data analysis calculations. 

Property 
Estimation 

Standalone Property Constant Estimation run 

Use Property Estimation to estimate property parameters when you do not want to perform a 
flowsheet simulation in the same run.  

Setup Run Types



Setup Units
• Units in Aspen Plus can be defined at 3 different levels:

1. Global Level (“Input Data” & “Output Results”
fields on the Setup Specifications Global sheet)

2. Object level (“Units” field in the top of any input 
form 

of an object such as a block or stream
3. Field Level

• Users can create their own units sets using the Setup
Units Sets Object Manager.  Units can be copied from 
an existing set and then modified.



Components

• Use the Components Specifications form to specify all the 
components required for the simulation.

• If available, physical property parameters for each 
component are retrieved from databanks.

• Pure component databanks contain parameters such as 
molecular weight, critical properties, etc. The databank 
search order is specified on the Databanks sheet.

• The Find button can be used to search for components.

• The Electrolyte Wizard can be used to set up an 
electrolyte simulation.



Step 2 : chemical species (Component Specifications Form)



Entering Components

• The Component ID is used to identify the component in 
simulation inputs and results.

• Each Component ID can be associated with a databank 
component as either:
- Formula:  Chemical formula of component (e.g., C6H6)
(Note that a suffix is added to formulas when there are isomers, e.g. 
C2H6O-2)
- Component Name:  Full name of component (e.g., BENZENE)

• Databank components can be searched for using the Find 
button.
- Search using component name, formula, component class, molecular 

weight, boiling point, pr CAS number.
- All components containing specified items will be listed.



Find

•Find performs an AND search when more than one 
criterion is specified.



Pure Component Databanks
 
Databank 

 
Contents 

 
Use 

 
PURE10 

 
Data from the Design Institute for Physical 
Property Data (DIPPR) and AspenTech 

 
Primary component databank in 
Aspen Plus 

 
AQUEOUS 

 
Pure component parameters for ionic and 
molecular species in aqueous solution 

 
Simulations containing 
electrolytes 

 
SOLIDS 

 
Pure component parameters for strong 
electrolytes, salts, and other solids 

 
Simulations containing 
electrolytes and solids 

 
INORGANIC 

 
Thermochemical properties for inorganic 
components in vapor, liquid and solid states  

 
Solids, electrolytes, and 
metallurgy applications 

 
PURE93 

 
Data from the Design Institute for Physical 
Property Data (DIPPR) and AspenTech 
delivered with Aspen Plus 9.3 

 
For upward compatibility 

 
PURE856 

 
Data from the Design Institute for Physical 
Property Data (DIPPR) and AspenTech 
delivered with Aspen Plus 8.5-6 

 
For upward compatibility 

   

Parameters missing from the first selected databanks will be searched for
in subsequent selected databanks.



Properties

• Use the Properties Specifications form to specify the 
physical property methods to be used in the simulation.

• Property methods are a collection of models and methods 
used to describe pure component and mixture behavior.

• Choosing the right physical properties is critical for 
obtaining reliable simulation results.

• Selecting a Process Type will narrow the number of 
methods available.



Step 3 : physical property (Property Specifications Global Form)



Streams

• Use Stream Input forms to specify the feed stream 
conditions and composition.

• To specify stream conditions enter two of the following:
– Temperature

– Pressure

– Vapor Fraction

• To specify stream composition enter either:
– Total stream flow and component fractions

– Individual component flows

• Specifications for streams that are not feeds to the
flowsheet (i.e. recycle streams) are used as estimates.



Step 4 : stream variables (Stream Specifications form)



Blocks

• Each Block Input or Block Setup form specifies 
operating conditions and equipment 
specifications for the unit operation model.

• Some unit operation models require additional 
specification forms

• All unit operation models have optional 
information forms (e.g. BlockOptions form).



Step 5 : equipment parameters (Block [Flash2] Specifications Form)



Starting the Run

• Select Control Panel from the View menu or press the Next 
button to be prompted.
– The simulation can be executed when all required forms are 

complete.

– The Next button will take you to any incomplete forms.



The Control Panel consists of:
– A message window showing the progress of the simulation by 

displaying the most recent messages from the calculations

– A status area showing the hierarchy and order of simulation 
blocks and convergence loops executed

– A toolbar which you can use to control the simulation

Control Panel

Run Start or continue calculations

Step Step through the flowsheet one
block at a time

Stop Pause simulation calculations

Reinitialize Purge simulation results

Results Check simulation results



Reviewing Results

• History file or Control Panel Messages
– Contains any generated errors or warnings
– Select History or Control Panel on the View menu to display the 

History file or the Control Panel

• Stream Results
– Contains stream conditions and compositions

• For all streams (/Data/Results Summary/Streams)
• For individual streams (bring up the stream folder in the Data 

Browser and select the Results form)

• Block Results
– Contains calculated block operating conditions (bring up the 

block folder in the Data Browser and select the Results form)



Examine result 1 : Aspen Plus Output 



Examine results : Aspen Plus Output - continued



Examine results : Aspen Plus Output - continued



Unit Operation Models

•Objective:
Review major types of unit operation models

Aspen Plus References:
•User Guide, Chapter 10, Unit Operation Models
•Unit Operation Models Reference Manual



Unit Operation Model Types

• Mixers/Splitters

• Separators

• Heat Exchangers

• Columns

• Reactors

• Pressure Changers

• Manipulators

• Solids

• User Models



Mixers/Splitters

 
Model 

 
Description 

 
Purpose 

 
Use 

 
Mixer 

 
Stream mixer 

 
Combine multiple 
streams into one 
stream 

 
Mixing tees, stream mixing 
operations, adding heat 
streams, adding work streams 

 
FSplit 

 
Stream splitter 

 
Split stream flows 

 
Stream splitters, bleed valves 

 
SSplit 

 
Substream splitter 

 
Split substream flows  

 
Solid stream splitters, bleed 
valves 



Separators
 
Model 

 
Description 

 
Purpose 

 
Use 

 
Flash2 

 
Two-outlet flash 

 
Determine thermal 
and phase conditions 

 
Flashes, evaporators, knockout 
drums, single stage separators 

 
Flash3 

 
Three-outlet 
flash 

 
Determine thermal 
and phase conditions 

 
Decanters, single stage separators 
with two liquid phases 

 
Decanter 

 
Liquid-liquid 
decanter 

 
Determine thermal 
and phase conditions 

 
Decanters, single stage separators 
with two liquid phases and no vapor 
phase 

 
Sep 

 
Multi-outlet 
component 
separator 

 
Separate inlet stream 
components into any 
number of outlet 
streams 

 
Component separation operations 
such as distillation and absorption, 
when the details of the separation are 
unknown or unimportant 

 
Sep2 

 
Two-outlet 
component 
separator 

 
Separate inlet stream 
components into two 
outlet streams 

 
Component separation operations 
such as distillation and absorption, 
when the details of the separation are 
unknown or unimportant 



Heat Exchangers

Model Description Purpose Use

Heater Heater or cooler Determines thermal
and phase conditions

Heaters, coolers, valves. Pumps and
compressors when work-related
results are not needed.

HeatX Two-stream
heat exchanger

Exchange heat
between two streams

Two-stream heat exchangers. Rating
shell and tube heat exchangers
when geometry is known.

MHeatX Multistream
heat exchanger

Exchange heat
between any number
of streams

Multiple hot and cold stream heat
exchangers. Two-stream heat
exchangers. LNG exchangers.

Hetran* Interface to
B-JAC Hetran
program

Design and simulate
shell and tube heat
exchangers

Shell and tube heat exchangers with
a wide variety of configurations.

Aerotran* Interface to
B-JAC Aerotran
program

Design and simulate
air-cooled heat
exchangers

Air-cooled heat exchangers with a
wide variety of configurations. Model
economizers and the convection
section of fired heaters.



Columns - Shortcut

Model Description Purpose Use

DSTWU Shortcut distillation
design

Determine minimum RR,
minimum stages, and either
actual RR or actual stages
by Winn-Underwood-
Gilliland method.

Columns with one feed and
two product streams

Distl Shortcut distillation
rating

Determine separation
based on RR, stages, and
D:F ratio using Edmister
method.

Columns with one feed and
two product streams

SCFrac Shortcut distillation
for petroleum
fractionation

Determine product
composition and flow,
stages per section, duty
using fractionation indices.

Complex columns, such as
crude units and vacuum
towers



Columns - Rigorous

Model Description Purpose Use
RadFrac Rigorous

fractionation
Rigorous rating and design for single
columns

Distillation, absorbers, strippers,
extractive and azeotropic distillation,
reactive distillation

MultiFrac Rigorous
fractionation for
complex columns

Rigorous rating and design for
multiple columns of any complexity

Heat integrated columns, air separators,
absorber/stripper combinations, ethylene
primary fractionator/quench tower
combinations, petroleum refining

PetroFrac Petroleum refining
fractionation

Rigorous rating and design for
petroleum refining applications

Preflash tower, atmospheric crude unit,
vacuum unit, catalytic cracker or coker
fractionator, vacuum lube fractionator,
ethylene fractionator and quench towers

BatchFrac*+ Rigorous batch
distillation

Rigorous rating calculations for
single batch columns

Ordinary azeotropic batch distillation,     
3-phase, and reactive batch distillation

RateFrac* Rate-based
distillation

Rigorous rating and design for single
and multiple columns.  Based on
nonequilibrium calculations

Distillation columns, absorbers, strippers,
reactive systems, heat integrated units,
petroleum applications

Extract Liquid-liquid
extraction

Rigorous rating for liquid-liquid
extraction columns

Liquid-liquid extraction

* Requires separate license and + Input language only in version 10.0



Reactors
Model Description Purpose Use
RStoic Stoichiometric

reactor
Stoichiometric reactor with
specified reaction extent or
conversion

Reactors where the kinetics are unknown or
unimportant but stoichiometry and extent are
known

RYield Yield reactor Reactor with specified yield Reactors where the stoichiometry and kinetics
are unknown or unimportant but yield
distribution is known

REquil Equilibrium reactor Chemical and phase
equilibrium by
stoichiometric calculations

Single- and two-phase chemical equilibrium
and simultaneous phase equilibrium

RGibbs Equilibrium reactor Chemical and phase
equilibrium by Gibbs
energy minimization

Chemical and/or simultaneous phase and
chemical equilibrium. Includes solid phase
equilibrium.

RCSTR Continuous stirred
tank reactor

Continuous stirred tank
reactor

One, two, or three-phase stirred tank reactors
with kinetics reactions in the vapor or liquid

RPlug Plug flow reactor Plug flow reactor One, two, or three-phase plug flow reactors with
kinetic reactions in any phase.  Plug flow
reactions with external coolant.

RBatch Batch reactor Batch or semi-batch
reactor

Batch and semi-batch reactors where the
reaction kinetics are known



Pressure Changers
Model Description Purpose Use

Pump Pump or
hydraulic
turbine

Change stream pressure when
the pressure, power requirement
or performance curve is known

Pumps and hydraulic turbines

Compr Compressor or
turbine

Change stream pressure when
the pressure, power requirement
or performance curve is known

Polytropic compressors, polytropic
positive displacement
compressors, isentropic
compressors, isentropic turbines.

MCompr Multi-stage
compressor or
turbine

Change stream pressure across
multiple stages with intercoolers.
Allows for liquid knockout
streams from intercoolers

Multistage polytropic compressors,
polytropic positive compressors,
isentropic compressors, isentropic
turbines.

Valve Control valve Determine pressure drop or
valve coefficient (CV)

Multi-phase, adiabatic flow in ball,
globe and butterfly valves

Pipe Single-segment
pipe

Determine pressure drop and
heat transfer in single-segment
pipe or annular space

Multi-phase, one dimensional,
steady-state and fully developed
pipeline flow with fittings

Pipeline Multi-segment
pipe

Determine pressure drop and
heat transfer in multi-segment
pipe or annular space

Multi-phase, one dimensional,
steady-state and fully developed
pipeline flow



Ex 2 : Hydrocarbon Distillation

•For the simulation of a depropanizer that involves five normal paraffins: 
ethane through n-hexane. 

320 psiaPress.

1000Total 

200C3

370NC4

225 oFTemp.

50NC6

350NC5

20C2

Feed, lbmole/hr 

LK

HK

C3 = 191 lbmole/hr
NC4 = 5 lbmole/hr

C3 = 9 lbmole/hr
NC4 = 365 lbmole/hr



Depropanizer New Design

1. Determine the number of tray to obtain:

a) C3 recovery at overhead : 99.5 %

b) NC4 recovery at overhead : 1.35 %

2. Determine the column pressure, based on a dew point 
condenser temperature of 130oF.

3. Use RK-Soave (SRK in PRO/II) method for VLE calculation.

4. Find an actual reflux ratio which minimizes the summation of 
total utility consumptions (operating costs) and theoretical 
number of stages (capital costs).



A. Partial   B. Bubble or sub-cooled

C. Mixed D. Mixed with decanter

How we can determine the condenser type?
or How we can determine the column pressure?



It depends on the refrigerant available and 
overhead compositions to be assumed.

• Overhead molar flow rate (assume)
C2 = 30, C3 = 191, NC4 = 5

• Normalize ! (Component mole %)
C2 = 13.27, C3 = 84.51, NC4 = 2.22

• First, we have to determine the dew point pressure !

130.00Temperature (oF)

?Dew P at 130 oF

2.22NC4

84.51C3

13.27C2

Mole %Component



Dew P Calculation (General Process Information)



Dew P Calculation (Component Specification)



Dew P Calculation (Physical Property Specification)



Dew P Calculation (Feed Stream Specification)



Dew P Calculation (Performance Specification)



Examine Results



Dew Pressure Calculation Results

•Condenser type = partial condenser
•Condenser operating temperature = 130oF
•Condenser Pressure = 299 psia
•Condenser pressure drop = 4 psia (assumed)
•Column pressure drop = 5 psia (assumed)

DSTWU modeling

•Partial condenser is utilized.
•RR = -1.75 (‘-’means a multiple of minimum reflux ratio.)



DSTWU modeling



DSTWU modeling



DSTWU modeling



DSTWU modeling



DSTWU modeling



DSTWU modeling Results



DSTWU modeling Case Study

----3.21Infinitive1.00

Infinitive

5.00

2.50

2.00

1.50

1.10

1.05

R/Rmin

----Infinitive10.9

41.9222.3219.606.916.0412.1

22.0612.399.677.78.0213.8

18.0910.407.698.06.4214.7

14.068.395.679.74.8117.9

10.836.774.0613.73.5326.1

10.366.543.8219.73.3738.3

UtilityReboiler
Duty

Condenser
Duty

Feed 
Tray

Reflux
Ratio

Number
of Tray

•Minimum Reflux Ratio = 3.21
•Minimum Number of Stages = 10.9



Reflux Ratio
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Shortcut Modeling Results using DSTWU

•File Name = DSTWU-F.bkp

•Optimum Reflux Ratio = 5.7

•Optimum Number of Stages = 16

•Feed Tray Location = 9

•Partial Condenser Temperature = 130 oF

•Overhead Condenser Heat Duty = 6.79 MM Btu/Hr

•Bottom Reboiler Heat Duty = 9.61 MM Btu/Hr

•C3 Recovery at Overhead Product = 95.5 %

•NC4 Recovery at Overhead Product = 1.34 %



Shortcut Modeling using DISTIL

•File Name = DISTIL.bkp

•Modeling using ‘DISTIL’ is an intermediate step between 
DSTWU and RadFrac

•DSTWU : 
- Nmin, Rmin, 
- Ratio, R/Rmin

- Ropt, Nopt, FTRAYopt

•DISTIL tells us a preliminary modeling results such as 
condenser, reboiler heat duties, condenser temperature &
material balances prior to performing rigorous modeling.



DISTIL (simulation flowshhet)



Comparison between ‘DSTWU’ and ‘DISTIL’

2.7 %1.34 %NC4 Recovery at Top

93.0 %95.5 %C3 Recovery at Top

9.639.06Reboiler Heat Duty

-6.94-6.79Condenser Heat Duty

134 oF130 oFCondenser Temperature

99Feed Tray Location

1616Number of Tray

5.75.7Reflux Ratio

DISTILDSTWU



RadFrac
•Objective:
Discuss the minimum input required for the RadFrac
fractionation model, and the use of design specifications 
and stage efficiencies

•Aspen Plus References:
Unit Operation Models Reference Manual, Chapter 4, Columns



RadFrac: Rigorous Multistage Separation

• Vapor-Liquid or Vapor-Liquid-Liquid phase simulation of:
– Ordinary distillation
– Absorption, reboiled absorption
– Stripping, reboiled stripping
– Azeotropic distillation
– Reactive distillation

• Configuration options:
– Any number of feeds
– Any number of side draws
– Total liquid draw off and pumparounds
– Any number of heaters
– Any number of decanters



RadFrac Setup Configuration Sheet

•Specify:
­Number of stages
­Condenser and reboiler configuration
­Two column operating specifications
­Valid phases
­Convergence



RadFrac Setup Streams Sheet

• Specify:
– Feed stage location
– Feed stream convention (see Help)

ABOVE-STAGE:
Vapor from feed goes to stage above feed stage
Liquid goes to feed stage

ON-STAGE:
Vapor & Liquid from feed go to specified feed stage



RadFrac Setup Pressure Sheet

•Specify one of:

­Column pressure profile

­Top/Bottom pressure

­Section pressure drop



RadFrac



RadFrac



RadFrac



RadFrac



RadFrac



RadFrac



RadFrac



Comparison between ‘DSTWU’, ‘DISTIL’, and ‘RadFrac1’

2.7 %

93.0 %

9.63

-6.94

134 oF

9

16

5.7

DISTIL

3.22 %

92.0 %

9.79

-7.11

135.3 oF

9

16

5.7

RadFrac1

1.34 %NC4 Recovery at Top

95.5 %C3 Recovery at Top

9.06Reboiler Heat Duty

-6.79Condenser Heat Duty

130 oFCondenser Temperature

9Feed Tray Location

16Number of Tray

5.7Reflux Ratio

DSTWU



RadFrac (Design Spec 1)



RadFrac (Design Spec 1)



RadFrac (Design Spec 1)



RadFrac (Variable 1)



RadFrac (Design Spec 2)



RadFrac (Design Spec 2)



RadFrac (Design Spec 2)



RadFrac (Variable 2)



Comparison between ‘DSTWU’, ‘DISTIL’, ‘RadFrac1’ & ;RadFrac2’

3.22 %

92.0 %

9.79

-7.11

135.3 oF

9

16

5.7

RadFrac1

2.7 %

93.0 %

9.63

-6.94

134 oF

9

16

5.7

DISTIL

1.34 %

95.5 %

13.67

-10.95

130 oF

9

16

9.14

RadFrac2

1.34 %NC4 Recovery at Top

95.5 %C3 Recovery at Top

9.06Reboiler Heat Duty

-6.79Condenser Heat Duty

130 oFCondenser Temperature

9Feed Tray Location

16Number of Tray

5.7Reflux Ratio

DSTWU



Kettle Reboiler 

T = 65 C
P = 1 bar

Water: 100 kmol/hr
Methanol: 100 kmol/hr

9 Stages
Reflux Ratio = 1
Distillate to feed ratio = 0.5

Column pressure = 1 bar
Feed stage = 6

RadFrac specifications

Filename: RAD-EX.BKP

Methanol-Water RadFrac Column

Use the NRTL-RK Property Method

COLUMNFEED

OVHD

BTMS

Total Condenser 



RadFrac Options

• To set up an absorber with no condenser or reboiler, set 
condenser and reboiler to none on the RadFrac Setup 
Configuration sheet.

• Either Vaporization or Murphree efficiencies on either a 
stage or component basis can be specified on the 
RadFrac Efficiencies form.

• Tray and packed column design and rating is possible.

• A Second liquid phase may be modeled if the user selects 
Vapor-liquid-liquid as Valid phases.

• Reboiler and condenser heat curves can be generated.



Plot Wizard

• Use Plot Wizard (on the Plot menu) to quickly generate 
plots of results of a simulation. You can use Plot Wizard 
for displaying results for the following operations:
– Physical property analysis

– Profiles for all separation models RadFrac, MultiFrac, PetroFrac
and RateFrac

• Click the object of interest in the Data Browser to 
generate plots for that particular object.

• The wizard guides you in the basic operations for 
generating a plot.

• Click on the Next button to continue.  Click on the Finish 
button to generate a plot with default settings.



Plot Wizard Demonstration (1)

•Use the plot wizard on the column to create a plot of 
the vapor phase compositions throughout the column.



Plot Wizard Demonstration (2)

•Use the plot wizard on the column to create a plot of 
the liquid phase compositions throughout the column.



RadFrac DesignSpecs and Vary

• Design specifications can be specified and executed 
inside the RadFrac block using the DesignSpecs and 
Vary forms.

• One or more RadFrac inputs can be manipulated to 
achieve specifications on one or more RadFrac
performance parameters.

• The number of specs should, in general, be equal to the 
number of varies.

• The DesignSpecs and Varys in a RadFrac are solved in a 
“Middle loop.” If you get an error message saying that the 
middle loop was not converged, check the DesignSpecs
and Varys you have entered.  



RadFrac Convergence Problems

If a RadFrac column fails to converge, doing one or more of 
the following could help:

1. Check that physical property issues (choice of 
Property Method, parameter availability, etc.) are 
properly selected.

2. Ensure that column operating conditions are feasible.

3. If the column err/tol is decreasing fairly consistently, 
increase the maximum iterations on the RadFrac
Convergence Basic sheet.



RadFrac Convergence Problems 
(Continued)

4. Provide temperature estimates for some stages in 
the column using the RadFrac Estimates 
Temperature sheet (useful for absorbers).

5. Provide composition estimates for some stages in 
the column using the RadFrac Estimates Liquid 
Composition and Vapor Composition sheet (useful 
for highly non-ideal systems).

6. Experiment with different convergence methods on 
the RadFrac Setup Configuration sheet.

>> When a column does not converge, it is usually 
beneficial to Reinitialize after making changes.



Filename: RADFRAC.BKP

RadFrac Workshop

Use 
1) Ideal Raoult’s Law
2) NRTL Property Method
3) NRTL-RK Property Method
4) RK-Soave Property Method

COLUMNFEED

DIST

BTMS

Feed:
63.2 wt% Water 
36.8 wt% Methanol
Total flow = 120,000 lb/hr
Pressure 18 psia 
Saturated liquid

Column specification: 
38 trays (40 stages)
Feed tray = 23 (stage 24)
Total condenser
Top stage pressure  = 16.1 psia
Pressure drop per stage = 0.1 psi
Distillate flowrate = 1245 lbmol/hr
Molar reflux ratio = 1.3

Part A:

• Perform a rating calculation of a Methanol tower using the following 
data:



RadFrac Workshop 
(Continued)

Part B:
• Set up design specifications within the column so the 

following two objectives are met:

- 99.95 wt% methanol in the distillate

- 99.90 wt% water in the bottoms

• To achieve these specifications, you can vary the distillate 
rate (800-1700 lbmol/hr) and the reflux ratio (0.8-2).  
Make sure stream compositions are reported as mass 
fractions before running the problem.  Note the condenser 
and reboiler duties:

Condenser Duty :_________

Reboiler Duty :_________



Heat Exchangers

•Objective:

Introduce the unit operation models used for heat 
exchangers and heaters.

•Aspen Plus References:
•Unit Operation Models Reference Manual, Chapter 3, 

Heat Exchangers



Heat Exchanger Blocks

• Heater - Heater or cooler

• HeatX - Two stream heat exchanger

• MHeatX - Multi-stream heat exchanger

• Hetran - Interface to B-JAC Hetran block

• Aerotran - Interface to B-JAC Aerotran block



Working with the Heater Model

The Heater block mixes multiple inlet streams to produce a 
single outlet stream at a specified thermodynamic state.

Heater can be used to represent:
– Heaters

– Coolers

– Valves

– Pumps (when work-related results are not needed)

– Compressors (when work-related results are not needed)

Heater can also be used to set the thermodynamic conditions 
of an outlet stream.



Heater Input Specifications

Allowed combinations:

• Pressure (or Pressure drop) and one of:
– Outlet temperature

– Heat duty or inlet heat stream

– Vapor fraction

– Temperature change

– Degrees of sub-cooling or superheating

• Outlet Temperature or Temperature change and one of:

– Pressure

– Heat Duty

– Vapor fraction



Heater Input Specifications (Continued)

For single phase use Pressure (drop) and one of:
– Outlet temperature

– Heat duty or inlet heat stream

– Temperature change

Vapor fraction of  1  means dew point condition, 
0  means bubble point



Working with the HeatX Model

• HeatX can perform simplified or rigorous rating 
calculations.

• Simplified rating calculations (heat and material 
balance calculations) can be performed if 
exchanger geometry is unknown or 
unimportant.

• For rigorous heat transfer and pressure drop 
calculations, the heat exchanger geometry 
must be specified.



HeatX Workshop

• Hydrocarbon stream

– Temperature: 200 C

– Pressure: 4 bar

– Flowrate: 10000 kg/hr

– Composition: 50 wt% benzene, 20% styrene, 
20% ethylbenzene and 10% water

• Cooling water 

– Temperature: 20 C

– Pressure: 10 bar

– Flow rate: 60000 kg/hr

– Composition: 100% water

Objective: Compare the simulation of a heat exchanger that 
uses water to cool a hydrocarbon mixture using three 
methods: a shortcut HeatX, a rigorous HeatX and two 
Heaters connected with a Heat stream.



HeatX Workshop (Continued)

RHEATX

RCLD-IN

RHOT-IN RHOT-OUT

RCLD-OUT

SHEATX

SCLD-IN

SHOT-IN SHOT-OUT

SCLD-OUT

HEATER-1

HCLD-IN

Q-TRANS

HCLD-OUT

HEATER-2

HHOT-IN HHOT-OUT

When finished, save as filename:  HEATX.BKP

Use the NRTL-RK Property Method for the hydrocarbon streams.

Specify that the valid phases for the hydrocarbon stream is Vapor-Liquid-Liquid.

Specify that the Steam Tables are used to calculate the properties for the cooling water 
streams on the Block BlockOptions Properties sheet.

Start with the General with Metric Units Template.



HeatX Workshop (Continued)

• Shortcut HeatX simulation:

– Hydrocarbon stream exit has a vapor fraction of 0

– No pressure drop in either stream

• Two Heaters simulation:

– Use the same specifications as the shortcut HeatX simulation

• Rigorous HeatX simulation:

– Hydrocarbons in shell leave with a vapor fraction of 0

– Shell diameter 1 m, 1 tube pass

– 300 bare tubes, 3 m length, pitch 31 mm, 21 mm ID, 25 mm OD

– All nozzles 100 mm

– 5 baffles, 15% cut

– Create heat curves containing all info required for thermal design.

– Change the heat exchanger specification to Geometry and re-run.



Pressure Changers

Objective:

Introduce the unit operation models used to change 
pressure: pumps, compressors, and models for 
calculating pressure change through pipes and valves.

Aspen Plus References:

Unit Operation Models Reference Manual, Chapter 6, 
Pressure Changers



Pressure Changer Blocks

• Pump - Pump

• Compr - Compressor or turbine

• MCompr - Multi-stage compressor or turbine

• Valve - Control valve or Pressure Let-down Valve

• Pipe - Single-segment pipe

• Pipeline - Multi-segment pipe



Reactor Models

Objective:

Introduce the various classes of reactor models 
available, and examine in some detail at least one 
reactor from each class

Aspen Plus References:
Unit Operation Models Reference Manual, Chapter 5, Reactors



Reactor Overview

Reactors

Balance Based
RYield
RStoic

Equilibrium Based
REquil
RGibbs

Kinetics Based
RCSTR
RPlug

RBatch


